Interactive Feature in this PDF Document

There are interactive features that allow you to jump to different locations within the document. Each listing in the Table of Contents is interactive. Place the cursor on either the text or the page number. A small hand with a pointing finger icon appears. Click to jump to that page. If you want to return to the Table of Contents, move the icon to the top of the page and click on the arrow marked TOC. Navigating from the Index (if there is one) is similar. Place the icon on one of the listings or page numbers, click on it, and it will move to that page. Returning to the Index can be done by clicking on the arrow marked Index.
Table of Contents

Section 1: Getting Started ................................................................. 1
A. Choosing a Good Location .................................................. 1
B. Unpacking and Inspection ............................................... 2
C. Identifying the Parts ......................................................... 3

Section 2: Label Stock ................................................................. 6
A. Label and Roll Specifications ........................................... 6
B. Installing Label Stock ...................................................... 9
C. Adjusting Gap Sensor Position ....................................... 12
D. Set the Stock Sensor Mode ............................................. 13
E. Set the Present/Cut Mode .............................................. 15

Section 3: Primera PrintHub ....................................................... 18
A. Monitoring Ink Levels ..................................................... 19
B. Using the Cost Estimator ................................................. 19
C. Replacing Ink Cartridges/Low Ink Warning ..................... 20

Section 4: Printing from a PC ...................................................... 23
A. Using BarTender® .......................................................... 23
B. Add Text, Barcodes and Graphics to a BarTender Label .... 30
C. Printing from BarTender ................................................. 31
D. Printing from Other Programs ......................................... 32
E. Adjusting Print Alignment ............................................. 33
F. Creating a Full Bleed Print ............................................. 35
G. Printer Driver Settings .................................................. 36

Section 5: Printing from a Mac .................................................... 40
A. Printer Utility Settings (Color Label 910 Utility) .............. 40
B. Adjusting Print Alignment/Label Offsets ......................... 42
C. Set the Stock Sensor Mode ........................................... 44
D. Set the Output Mode ................................................... 45
E. Printing from Belight Labels and Addresses .................. 47
F. Create a Custom Label Size/Print from other Programs .... 54
G. Creating a Full Bleed Print ........................................... 55
H. Printer Driver Settings ................................................ 56

Section 6: Troubleshooting and Maintenance ............................. 58
A. Solving Print Alignment Problems .................................. 58
B. Solving Print Quality Problems .................................... 61
C. Color Matching and Design Tips ................................... 63
D. Poor Print Quality – Cleaning the Cartridge ................... 65
E. Interpreting the Printer’s Indicator Lights ....................... 68
F. Technical Support ....................................................... 69

Section 7: Technical Specifications ............................................ 70

Index ......................................................................................... 71
Section 1: Getting Started

THANK YOU...

...for choosing an LX910 Color Label Printer. The LX910 Printer will print razor-sharp text and barcodes, vibrant colors, and even stunning photo-realistic photographs directly onto rolls of labels, card stock and a variety of other approved media.

This User's Manual is your complete step-by-step guide to quickly and easily setting up and printing with your new Color Label Printer!

A. CHOOSING A GOOD LOCATION

- Place the printer on a flat surface in a location with adequate air circulation to prevent internal heat build up.
- Do not place the printer near heat sources such as radiators or air ducts, or in a place subject to direct sun light, excessive dust, mechanical vibration or shock.
- Allow for adequate clearance in front of the printer to accommodate the printed label stock as it is leaving the printer to avoid the possibility of binding or jamming of the label stock.
- Allow for adequate overhead and left side clearance for opening the top cover to allow easy access to the label stock and ink cartridge. The printer will require 9.5 inches (24 cm) of additional space on the left side to completely open the cover (Total = 26.75" or 68 cm). The printer will require an additional 15.9 inches (40.4 cm) of overhead space to open the cover (Total = 25" or 63.5 cm).
B. UNPACKING AND INSPECTION

While unpacking your printer, inspect the carton to ensure that no damage has occurred during shipping. Make sure that all supplied accessories are included with your unit. The following items are included in the supply box:

1. Power Adapter
2. Separate Power Cord
3. 6’ USB Cable (If other USB cable is used, it must be 6’(2 M) or less.)
4. Color Dye Ink Cartridge Part Number 53492
   *Coming Soon - Pigment Ink Cartridge Part Number 53493
5. Warranty Statement and Registration Card

The following items are inside the printer supply roll area:
6. Starter Roll of High Gloss Label Stock

Save the carton and packing materials. They will come in handy when transporting the printer.
C. IDENTIFYING THE PARTS

This illustration shows the front of the printer with its control buttons and LED indicator lights.

The **Pause Button** is pressed to pause a job to allow for loading of label stock and ink cartridges. The printer pauses after the printing of the current label has finished. The Pause LED will illuminate when the printer is paused.

The **Power LED** indicates that the printer is on and ready to receive print jobs.

The **Load/Feed Button** is pressed in order to load label stock if the printer does not automatically detect the stock. When stock is loaded each press of the button will cause one label to be fed through the printer.

The **Ink Low LED** will illuminate when a cartridge has 10% or less of its ink remaining.

The **Unload Button** will unload the installed label stock by reversing it through the printer. Make sure to tear off the printed labels before pressing the Unload Button.

The **Label Tear Bar** is a serrated edge for conveniently tearing your finished labels from the printer. The printer comes with a white tear bar guard. For smoother label feeding, leave the guard in place during printing. When you are ready to tear off a label, remove the guard, tear off the label and replace the guard.
This illustration shows the input ports and power switch found on the rear panel of the printer.

The next two illustrations show the interior of the printer.
A. LABEL AND ROLL SPECIFICATIONS

A wide variety of label stock can be used in the printer. Refer to the specifications and settings in the following sections before ordering custom stock from Primera or any stock from another company.

**Important!** Test all custom made label stock with the intended printer before ordering large quantities! Primera will only assume responsibility for custom label stock ordered from Primera.

**Label Sensing Methods**

**Method 1:** Label Gap Sensing

**Method 2:** Through-Hole Sensing

**Method 3:** Reflective/Black Mark Sensing

(Black Mark must be printed on back side of label stock)

Note: See table below for Max and Min values in inches and mm.
<table>
<thead>
<tr>
<th></th>
<th>Max</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label width</td>
<td>8.25&quot; (209mm)</td>
<td>0.5&quot; (13mm)</td>
</tr>
<tr>
<td>Liner/media width</td>
<td>8.375&quot; (212mm)</td>
<td>1.5&quot; (38mm)</td>
</tr>
<tr>
<td>Label height/length</td>
<td>24&quot; (609mm)</td>
<td>0.5&quot; (13mm)</td>
</tr>
<tr>
<td>Gap between labels</td>
<td>10&quot; (253mm)</td>
<td>0.10&quot; (2.5mm)</td>
</tr>
<tr>
<td>Width of through-hole opening</td>
<td>0.5&quot; (12.65mm)</td>
<td>0.25&quot; (6.325mm)</td>
</tr>
<tr>
<td>Gap Sensor Adjustment Range (from left edge)</td>
<td>1.9&quot; (48mm)</td>
<td>0.20&quot; (5.06mm)</td>
</tr>
<tr>
<td>Reflective/Black Mark Width*</td>
<td>N/A</td>
<td>0.1&quot; (2.54mm)</td>
</tr>
<tr>
<td>Max Outer Diameter (OD)</td>
<td>6.0&quot;(152.4mm)</td>
<td>N/A</td>
</tr>
<tr>
<td>Inner Core Diameter (ID)</td>
<td>3.0&quot; (76.2mm)</td>
<td>3.0&quot; (76.2mm)</td>
</tr>
<tr>
<td>Total Thickness (Liner + Label)**</td>
<td>.0010&quot; (10 mil)</td>
<td>N/A</td>
</tr>
<tr>
<td>Distance from edge of media to edge of label</td>
<td>Printer driver assumes 2 mm gap. However, this is adjustable via the left margin offset.</td>
<td></td>
</tr>
</tbody>
</table>

* The Reflective/Black Mark should be opaque to infrared light. The mark should be between the labels. The end of the mark should correspond with the beginning of the label.

** This is the recommended maximum. There are two factors that determine whether the printer will accept any particular stock thickness.

1. The ability for the printer to pull the paper through the print area.
2. The ability for the sensor to read through the backing if the sensor is set to die-cut.

If you are printing in continuous or reflective label sensing mode number 2 does not apply. The fact that the printer must read through the backing in die-cut mode will limit the thickness much more than the printer's ability to pull the paper through the print area. However, if you adjust opacity level of the liner enough to allow the label to be seen by the stock sensor, the thickness will only be limited by the printer's ability to pull it through the printer area. For these reasons the weight or thickness of the liner is a variable that can not easily be defined. Primera recommends and uses 40# liner with all label stock.

*It is important to test all label stock with the intended printer before ordering large quantities!
Note on Label Orientation: If you are using an applicator to apply your labels, be sure to order label stock with the correct orientation for your applicator. For example, most applicators will apply the side of the label first, so you will want to print the labels sideways.
B. INSTALLING LABEL STOCK

The following steps will guide you through loading label stock into your printer:

Make sure power is connected and printer is on.

1. Open the Top Cover.

2. Lower the Roll Guide and pull it outward to make room for your label stock.
3. Remove any shipping tape from your label stock roll to ensure that it can unroll freely, making certain that no adhesive portion is exposed. It is important to note that any exposed adhesive surface can attach itself to the inner workings of the print mechanism and cause a media jam.

4. Place your roll of label stock on the Roll Arm and push it inward until it touches the Roll Stop.

5. Flip up the Roll Guide and slide it inward until it touches the label stock. The Roll Guide will automatically pull back slightly to the correct position. There should be approximately a 1mm gap between the Roll Guide and the roll.

**Important Note:** Be aware that some label stock may have a core that is slightly too large for the roll or the labels may have wrapped unevenly causing some to stick out beyond the edge of the core. Both of these issues can cause feeding problems.
6. Pull the Movable Throat Guide outward to make room for the label stock.

7. Place the leading edge of the label stock under the "label stock" symbols on the Throat Guides. The label stock should be placed far enough into the throat of the printer to correctly position the Movable Throat Guide but not yet into the printer itself.

8. Slide the Movable Throat Guide inward until it almost touches the label stock.

_Important Note:_ The label stock should be close enough to the Fixed and Movable Throat Guides to provide proper guidance but not close enough to pinch the label stock. (0-1 mm gap on either side) If the label stock is pinched by the guides, poor print quality or feeding problems could result.

9. Feed the label stock further into the printer until it senses the label and automatically feeds it through the printer. If the printer fails to feed the label stock, press the Load/Feed button on the front panel while continuing to guide the label stock into the printer. If the printer does not automatically grab and feed the stock or continues to feed the stock without stopping check the Gap Sensor position or mode (Section 2C or 2D).
C. ADJUSTING THE GAP SENSOR POSITION

If you are using label stock other than standard square / rectangular die-cut labels such as circular die-cut labels or through-hole stock use the instructions below to adjust the position of the label stock gap sensor. The sensor can be adjusted using the slide bar on the inside of the printer. Below the slide bar is a measurement which represents the distance between the edge of the label stock and the sensor. Measure the distance from the edge of the label stock to the correct position on the stock. Set the sensor so the side of the slide bar lines up to this measurement. See dashed line in the illustration below.

**Important Note:** You must adjust the stock sensor before loading nonstandard label stock.

<table>
<thead>
<tr>
<th>in.</th>
<th>2.0</th>
<th>1.5</th>
<th>1.0</th>
<th>0.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm</td>
<td>50.8</td>
<td>38.1</td>
<td>25.4</td>
<td>12.7</td>
</tr>
</tbody>
</table>

Circular Labels

If you are using Circular Labels you must adjust the stock sensor to correspond with the very top of the label where the circles are closest together. If the sensor is too far to the right or the left the printer will still sense the label but the image may be offset downward because the printer will start printing at the wrong position. If you are using stock that has multiple labels across make sure the sensor corresponds to a place on the stock that has a label and not a vertical gap.
The sensor can only be moved a maximum of 2 inches from the left side of the printable area. This means that the maximum diameter circular label that can be printed is 4 inches. For circular labels larger than 4 inches in diameter, you must have a black mark printed on the back of the label stock. This means that you must change the Stock Sensor Mode to Reflective. The printer will now look for the black mark representing the beginning of the next label instead of the die-cut. For more information on changing the Stock Sensor Mode see Section 2D.

**Through-Hole Labels**

If you are using card stock or label stock that has a hole punch or a notch to identify a transition from backing to label, you can adjust the Stock Sensor to position it over the identifying mark.

**D. SET THE STOCK SENSOR MODE**

The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To adjust the stock sensor mode, open the PrintHub. In most cases you will NOT need to change this setting. By default it is set to sense standard die-cut labels. It is only necessary to change this setting if you are using clear labels or any label with a black sensing mark on the back.
1. Connect the printer via USB and turn on the power. The Stock Sensor Mode setting is stored in the printer’s internal memory so you will not be able to access it unless the printer is turned on and properly communicating with the computer.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.

3. Click on the Label Feed (3rd tab from left).

4. Select the Stock Sensor Mode by clicking on the graphic that most closely corresponds to the stock you intend to install.

5. Load the label stock after you have set the sensor mode.

There are three sensor modes:

**Die-Cut (Default).** If you are using standard die-cut labels that look similar to the graphic, use this setting regardless of the size of the label. Also, use this setting for Through-hole label material where a hole is punched through each label or a notch is cut in the side.

**Reflective.** Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates the break between labels. Black marks are required on clear label stock rolls, or label where the label waste matrix (waste) is left on the liner. Black marks can also be used for irregular shaped labels, circles larger than 4 inches or on any stock where the print starting position can not be sensed using the label itself.
**Continuous.** (Sensor off) If you have continuous stock with no die-cut, reflective mark or holes, set the sensor type to Continuous. This will turn off the stock sensor. In this mode there is no way to set the print starting position. The printer will simply start printing the first label and print each subsequent label immediately after that previous one. To produce a gap between prints simply add the desired amount of white space to the end of the label being printed.

**Important Note:** You must also set the Stock Sensor Position (Section 2C) so that the sensor is sensing the correct point on the label stock.

---

**E: SET THE PRESENT/CUT MODE**

Use the Present/Cut Mode to adjust how the printer presents labels after they are printed or if/when they are cut after printing. To adjust the Present/Cut Mode, open the PrintHub program.

1. Connect the printer via USB and turn on the power. The Output/Cut Mode Setting is stored on the printer main board so you will not be able to access it unless the printer is turned on and properly communicating with the computer.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.

3. Click on the Label Feed Tab.

4. Click on the Output/Cut Mode button.

There are different options available which change if the Cutter is enabled or disabled. If the Cutter is disabled the label present options will be available. If the Cutter is enabled the present options are are no longer available but cut options become available.
Cutter Options:

Cut after button press. This setting will cut after you press the Load/Feed button on the printer. This can be used after one label or an entire job. This feature is useful if you will not be present at the end of the print to catch the cut label.

Cut after label count. This option will cut after the number of labels specified in the toggle box that appears when this option is selected. This is useful if you have front/back labels or sets of labels.

Cut after no activity. This setting will cut at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to cut at the end of multi-copy job, multi-page job or multiple individual jobs in the queue.

Cut every label. This setting will cut after every label.
Present Options:

**Do not present.** In this mode the label stock does not move after the last label is printed. This means that part of the last label printed is still in the printer. This should be used only if you have a label rewinder attached.

**Present after no activity.** This setting will present (feed all printed labels past the tear off point) at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to present at the end of a multi-copy job, a multi-page job or multiple individual jobs in the queue.
Section 3: Primera PrintHub

Primera PrintHub is used to interact with the printer for gathering ink levels, maintenance, alignment, cost calculation and several other functions. You can use it to manage these functions on multiple LX910 printers and other Primera label printer models.

PrintHub automatically installs with your printer driver and can be accessed through the printer driver preferences or as a program on your Windows start menu.

1. Connect the printer via USB and turn on the power. The PrintHub accesses most of the information it uses from the printer itself so the printer must be turned on and communicating for the program to be useful.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.

A. Adjust alignment, sensor mode, output mode and advanced settings.

B. If you have multiple Primera printers connected, they will be listed here.

C. Past jobs will show the last 5 jobs along with cost information. Click the document icon to view a cost report.

D. Application Settings

E. Print Queue shows the currently printing job.

F. Order Link

G. Frequent Activities

H. Current Ink Levels

18 PrintHub
**A: MONITORING INK LEVELS**

Ink levels can be monitored at any time by using the PrintHub. Immediately after printing starts the PrintHub will display the ink levels in the upper right corner of the application. Ink is displayed in 10% increments. Example 100% to 90% to 80% etc.

**B. USING THE COST ESTIMATOR**

The cost estimator is found under the queue section on the first tab of the PrintHub. The last five job costs are stored in the list. Each job will show the cost per label based on the cost per cartridge entered below the list. Enter the actual cost of the cartridge you paid. Prints remaining on the currently installed cartridge and total prints on new cartridge are both displayed.
To see a printable/saveable report click on the document icon next to the job you want to see. A report will display the information. You can print or save the report from this screen. You can also change the currency using the drop down, change the job name or adjust the cost from this screen.

**Important Note:** The cost per label represents the average cost per label over an entire run of labels. This means that the per label cost will decrease and become more accurate as the number of labels printed increases. This is because the ink that is used for periodic cartridge maintenance is divided into a larger number of labels. Primera recommends printing at least 5 labels for an accurate per label cost.

**C. REPLACING INK CARTRIDGES / LOW INK WARNING**

You can replace cartridges at any time or wait for the Low Ink Warning to prompt you to replace cartridges. The first and only ink low warning will occur at 0% ink remaining. Press the Load/Feed button to continue printing after you receive this warning.
To change a cartridge, follow this procedure:

1. Open the Cover. Lift from back corner of Cover

2. Press or pinch the tab on the front of the cartridge holder.

3. Remove the cartridge.
4. Locate a new cartridge and remove it from its packaging. Remove the foil outer package and the tape covering the nozzles.

5. Place the new cartridge into the empty carriage. Note: When installing the cartridge, tilt the cartridge at a slight backward angle of approximately 30 degrees.

6. Close the lid on the cartridge by lightly pressing down from the top until you hear a click.
A. USING BARTENDER®

Primera Special Edition BarTender UltraLite is included with the LX910. Other programs can be used to print. If printing from other programs please follow the guidelines in Section 4D.

When you open BarTender you will be given the choice to select an existing label or create a new one using a wizard. Use the following instructions as a guide through the wizard setup process.

1. Choose "Start a new BarTender document..."
2. Select "Blank Template". Click "Next".

3. Select "Color Label 910". Click "Next".
4. Select "Specify Custom Settings". Click "Next".

5. Set the page size, width and height to match labels installed in the printer. Click "Next".
6. Select your label shape. This is typically "Rounded Rectangle" for standard labels from Primera. Click Next.

7. Set all of the margins to zero. (You can adjusted the left margin and Top of Form in the Label Alignment Section). Click Next.
8. Set Rows and Columns to 1 for a standard label. Click Next.

9. Set Template Size to be the same as the label size. Click Next.
10. Check the "Picture" box to add a background photo or graphic to your label. Click "Next". If you click "Finish", the remaining default wizard options will be set and no picture will be added.

11. Select "Embedded Picture". Click the "File" Button to browse to the location of your photo/graphic file. Set the Size Method to "Stretch". Note the preview to the right. Click "Next" if you are satisfied with the layout of the photo or graphic. Otherwise you may try one of the other Size Methods in the drop down menu.
12. Review the label setup summary. If it is correct, click "Finish". Your blank label or label with background will be displayed.

You can edit any of these initial settings by going to the File Menu and selecting "Page Setup". Basic and advanced settings are available on the various tabs.
B. ADD TEXT, BARCODES AND GRAPHICS TO A BARTENDER LABEL

Once you have created your label size you will be able to add text, a barcode and/or graphics. This can be done using one of the buttons on the button bar at the top of the screen.

Add Text. Click the Text button. Now click anywhere on your label. “Sample Text” will appear. Edit the text on screen or double-click it to open up text settings to change font, size and other settings.

Add Barcode. Click the Barcode button. Now click anywhere on your label. A barcode settings window will appear. Here you can choose any type of barcode and enter the value.

Add Graphic. Click the Image button. Now click anywhere on your label. An Image icon will appear. Double-click it to open up image settings and browse to the image/graphic that you would like to insert.

Add Text.

Add Barcode.

Add Graphic.

Tip! Double-click any object to open settings for that object.

Tip! Go to the Help menu to access the BarTender Manual and Tutorials.

Print. Click the Print button to start printing.

Lines. Click the Line button to add a horizontal or vertical line.

Page Setup. Click the Page Setup button to change your label size, adjust corner radius or change the shape.
C. PRINTING FROM BARTENDER

1. To print, click the Print button or go to the File Menu and select "Print". The Print Dialog window will appear.

2. Select the Color Label 910.

3. Set the number of copies.

4. Click "Print".

Tip! Click on "Document Properties" to adjust driver settings like Print Quality and Color Matching.
D. PRINTING FROM OTHER PROGRAMS

Since this printer uses a standard Windows printer driver you can print from any application you would like. There are just a few things to remember that will make it much easier.

1. **Set the Page/Label Size in the Driver.** BarTender automatically prompts you for the size of the label that you are using. When printing from any other program you must do this manually. Before you print, simply set the custom page size just as you would set print quality in the printing preferences. In the example below the label size is 4" x 43" so the custom page size is set to 400 x 4300 (displayed in .01 inch units).

2. **Check the image or document size.** The image size or document size set in Illustrator should match to the Page/Label Size set in the driver. If you have set your page size to 4" x 4" but your image is actually 5" x 3" the printer driver will automatically shrink your image to fit inside the 4" x 4" label. The result is that the actual printed label is 4" x 2.4". Avoid this by setting your document size or image size to match the label size.
3. **Choose the right printing program.** There are many different applications that are capable of printing to the LX910. However there are only a few that are ideal printing applications. For example, Adobe Illustrator is an excellent design program but is not always the best printing program. It can be difficult to find the printing preferences or to know the exact size of the art board. It is best to save as a PDF file and print from Adobe Reader or export as a 300 dpi JPG and print from BarTender.

**E. ADJUSTING PRINT ALIGNMENT**

If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper you probably are not familiar with an essential part of a label printing - Print Alignment. Standard printers feed a sheet and start printing based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment. The LX910 senses the beginning of the label with an optical sensor and is capable of printing to top, bottom, left and right edge. Because of this it is necessary to align the printer to work with specific types of label stock.

The LX910 comes factory calibrated to print exactly to the edge of Primera label stock. However, due to variations in the left margins and other variables it may be necessary to fine tune these settings at the beginning of each roll. This is especially true for other non-Primera brand label stock.

**Important Note:** Before adjusting alignment settings first print one label at the quality level you intend for the entire job. This will ensure the label stock is moving at the same speed and the stock sensor will sense the gap in the same way.
Adjust print alignment using the PrintHub. Go to the Print Alignment Tab (second tab).

**Important!** Before adjusting any values, print the Test print to see how close you are to alignment. The on screen graphic is the same as the print which makes it easier to adjust these values.

Three items can be adjusted here:

- **Tear off/Cut Position.** This value adjusts the position of the last label printed after it has been presented for tear off or for cutting. This only applies if the output mode is set to "Present the label." Add to the current value to move the tear point closer to the printer. Subtract from the current value to move the tear point away from the printer. The value is automatically saved as soon as you set it.

- **Left Margin Offset.** This value moves the printed label left or right. Add to the current value to move the printed label to the right. Subtract from the current value to move the printed label to the left.

**Note:** Before adjusting this value make sure the label stock is properly loaded so that there is no gap between the edge of the liner and the fixed throat guide. Any gap at this point will greatly affect the Left margin offset value needed to align the label. Also, if you adjust the value with improperly loaded label stock you will have to adjust it again if you load the label stock correctly the next time.
• **Top of Form (TOF).** This value moves the print start position up or down on the label. Add to the current value to move the printed label down or toward the printer. Subtract from the current value to move the printed label up or away from the printer. The value is automatically saved as soon as you set it.

You may have to make several adjustments to one or more of these values. After each adjustment you can click the Test button to print a small test pattern on the label. This will help you find the proper alignment value.

F. CREATING A FULL BLEED PRINT

1. To create a label that completely fills the space with no white margins, adjust these settings in the status monitor and printing application (BarTender).

**Page Size.** Increase the page size width by .03 inches (1mm). Increase the height by .03 inches (1mm). If you are using BarTender, simply change the size under the File Menu - Page Setup. If you are using other graphics programs you will need to change the page size in the application and in the printer driver preferences.

**Left Margin Offset.** You must decrease the left margin offset to center the over bleed on the label. If you over bleed by .03" you will need to decrease the Left Margin Offset by 0.4mm. This will center the page size increase so there is a .03 inch over bleed on both left and right sides. Some additional adjustment may be necessary if the label was not perfectly aligned to begin with. See Section 4E.
TOF: Increase the Top of form by 0.4mm. This will cause the printer to start printing before the label and ensure a fully printed label. Some additional adjustment may be necessary if the label was not perfectly aligned to begin with. See Section 4E.

Note: It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause the printer to skip labels. This is because the printer stops printing too late to sense the next label.

G. PRINTER DRIVER SETTINGS

Once the printer driver has been successfully installed, you will need to setup the driver with the appropriate print options. Refer to the following steps to change or verify your default printer driver preferences. These settings will apply to all new designs created in BarTender or other programs after the preferences were changed. Existing labels saved in BarTender will not be affected since the preferences are saved with the label. To change these preferences you will have to change printer preferences through BarTender. (File Menu - Printer Settings)
To find Driver Settings:

Click the Start button, search for "Printers". Select Printers and Scanners. Select the Color Label 910. Choose Manage. Select Printing preferences.

The preferences screen will appear.

Note on PC Settings:

Most applications allow you to change these same printer driver options from their "Print" and/or "Printer Setup" screens. Some applications such as BarTender save your settings with the label, others use settings only for the current print job just sent to the printer.
Paper Size

If you are using BarTender, this setting is adjusted during the label setup wizard. If you are using a program other than BarTender you will need to set this to the dimensions of your label. Keep in mind that the dimensions are always relative to the width and height of the actual label in the printer. Orientation of an image on the label should not change this setting. See Section 2A for minimum and maximum label sizes.

Orientation

There are two settings for orientation, Portrait and Landscape. If your text and graphics print left to right or as shown on the screen, select portrait. If you wish your printing to rotate 90 degrees from what you see on the screen so it is printing horizontally, select landscape as your orientation. Remember, this does not change the width and height Paper Size. It is only a tool for viewing a label upright on screen that will be printed sideways on the printer.

Print Quality

There are 4 levels of print quality in the driver. The lower the quality, the faster the print. Quality 1 provides the fastest print available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when designing your label to find a good balance between print quality and print speed. Quality 2 is the default.

Color Matching

There are several options available depending on which cartridge is installed (Pigment or Dye). The options will update automatically depending on which cartridge is installed.
**Vivid Graphics** mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

**Vivid Photos** mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Vivid Graphics mode. Skin tones especially will look more natural in this mode.

**ICC Gloss Paper, ICC Gloss Polyester and ICC Matte Bopp** are all ICC calibrated color matching options. Select the setting that corresponds to your installed Primera media of the same type to produce ICC color matched prints. Note: ICC monitor calibration and additional setup is required for this option to work.

-NONE- will use no color matching.

**Ink Saturation**

This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the most accurate color matching. If the ink is not drying fast enough or "bleeding", you can decrease the Ink Saturation to lessen the amount of ink that is applied to the label.

**Rotate 180 Degrees**

Set this setting to Yes to print with the labels right side up as they exit the printer.

**Enable Bi-di**

Set to "Yes" for fastest print speed. Requires an alignment print after every cartridge change. Set to "No" for better quality print (in some cases).

**Launch PrintHub**

This setting will open the Primera PrintHub application.

**Details**

Select this setting to see current firmware and driver version information and other printer settings.
Section 5: Printing from a Mac

A. PRINTER UTILITY SETTINGS (COLOR LABEL 910 UTILITY)

The Color Label 910 Utility is used to interact with the printer for gathering ink levels, maintenance, alignment, and several other functions.

To Find Color Label 910 Utility:

Color Label 910 Utility automatically installs with your printer driver and can be accessed through the Printer & Scanners in Mac under Apple Icon – System Preferences.

1. Connect the printer via USB and turn on the power. The Color Label 910 Utility accesses most of the information it uses from the printer itself so the printer must be turned on and communicating for the program to open.

2. Go to the Apple Icon – System Preferences - Printers and Scanners, select the PTI Color_Label_910, click on, Options & Supplies, and Open Printer Utility. Or you may simply print to the printer and the Utility will open. The Color Label 910 Utility has 4 tabs that are arranged on the top of the window. Each tab opens a screen that has various similar functions.
- **Status Tab** (First Tab). Displays ink levels, print counter and any error messages.

- **Cartridge Tab** (Second Tab). Use for aligning the cartridge, cleaning the cartridge, and changing cartridge.

- **Alignment Tab** (Third Tab). Adjusts vertical and horizontal print alignment. Changes the Stock Sensor Mode and toggles the Output/Cut Mode.

- **Settings Tab** (Fourth Tab). Displays printer information including firmware version, driver version, and software version. Check for updates and set other advanced settings.
B. ADJUSTING PRINT ALIGNMENT/LABEL OFFSETS

If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper you probably are not familiar with an essential part of label printing – Print Alignment. Standard printers feed a sheet and start printing based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment. The LX910 senses the beginning of the label with an optical edge. Because of this it is necessary to align the printer to work with specific types of label stock.

The LX910 comes from the factory calibrated to print exactly to the edge of Primera label stock. However, due to variability it may be necessary to fine tune these settings at the beginning of each roll. This is especially true for other non-Primera brand label stock.

**Important Note:** Before adjusting alignment settings first print one label at the quality level you intend for the entire print job. This will ensure the label stock is moving at the same speed and the stock sensor will sense the gap in the same way.

Adjust print alignment using the Color Label 910 Utility. Click on the Alignment Tab (Third Tab).
Three items can be adjusted here:

* **Tear off Position.** This value adjusts the position of the last label printed after it has been presented for tear off. This only applies if the output mode is set to “Present.” Add to the current value to move the tear point closer to the printer. Subtract from the current value to move the tear point away from the printer. After adjusting the value click the Set Offsets button to send the value to the printer.

* **Left Margin Offset.** This value moves the printed label left or right. Add to the current value to move the printed label to the right. Subtract from the current value to move the printed label to the left. After adjusting the value, click the Set Offsets button to send the value to the printer.

**Note:** Before adjusting this value make sure the label stock is properly loaded so that there is no gap between the edge of the liner and the fixed throat guide. Any gap at this point will greatly affect the Left Margin Offset value needed to align the label. Also, if you adjust the value with improperly loaded label stock you will have to adjust it again if you load the label stock correctly the next time.

* **Top of Form (TOF).** This value moves the print start position up or down on the label. Add to the current value to move the printed label down or toward the printer. Subtract from the current value to move the printed label up or away from the printer. After adjusting the value click the Set Offsets button to send the value to the printer.

You may have to make several adjustments to one or more of these values. After each adjustment you can click the Test Offsets button to print a small test pattern on the label. This will help you find the proper alignment value.
The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To access the Stock Sensor Mode, click on the Alignment button, then select Stock Sensor Mode. In most cases you will not need to change this setting.

**Important Note:** Set the Stock Sensor Mode **BEFORE** loading label stock! You must also set the Stock Sensor Position (Section 2C) so that the sensor is sensing the correct point on the label stock.

**Die Cut (Default).** If you are using standard die-cut labels that look similar to the graphic use this setting regardless of the size of the label. Also, use this setting for through-hole label material where a hole is punched through each label or a notch is cut on the side.

**Reflective.** Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates the break between labels. Black marks are required on clear label stock rolls, or labels where the label waste matrix (waste) is left on the liner. Black marks can also be used for irregular shaped labels, circles larger than 4.6 inches or on any stock where the print starting position can not be sensed using the label itself.
Continuous. (Sensor off.) If you have continuous stock with no die-cut, reflective mark or holes, set the Sensor Type to Continuous. This will turn off the stock sensor. In this mode there is no way to set the print starting position. The printer will simply start printing the first label and print each subsequent label immediately after the previous. To produce a gap between prints simply add the desired amount of white space to the end of the label being printed.

D. SET THE OUTPUT MODE

Use the Present/Cut Mode to adjust how the printer presents labels after they are printed or if/when they are cut after printing. There are different options available which change if the Cutter is enabled or disabled. If the Cutter is disabled the label present options will be available. If the Cutter is enabled the present options are are no longer available but cut options become available.

Cut Options (Check Cutter Enabled):

Cut after no activity. This setting will cut at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to cut at the end of multi-copy job, multi-page job or multiple individual jobs in the queue.

Cut after button press. This setting will cut after you press the Load/Feed button on the printer. This can be used after one label or an entire job. This feature is useful if you will not be present at the end of the print to catch the cut label.

Cut every label. This setting will cut after every label.
Cut after label count. This option will cut after the number of labels specified in the toggle box that appears when this option is selected. This is useful if you have front/back labels or sets of labels.

Present Options (Uncheck Cutter Enabled)

Do not present. In this mode the label stock does not move after the last label is printed. This means that part of the last label printed is still in the printer. This should be used only if you have a label rewinder attached.

Present after no activity. This setting will present (feed all printed labels past the tear off point) at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to present at the end of a multi-copy job, a multi-page job or multiple individual jobs in the queue.
E. PRINTING FROM BELIGHT LABELS AND ADDRESSES

You can print to the printer from any program. However, Belight’s Labels and Addresses is an affordable program that we recommend. It saves time by eliminating the need to setup a custom page size for each label. You may download a trial version at their website: www.belightsoft.com

To setup a label and print follow these instructions.

1. When you open the program for the first time, a label assistant will be displayed. You may choose a predefined label if your label size is on the list.
2. If your size is not on the list, select ANY label and click Choose. You will have to setup a new label before it will appear on the Custom tab. Click on the information icon to display label size information. Click on Change Layout...

3. Click on the Custom Tab. Choose Create New. Click OK.
4. The setup will contain a default name and setup. All of this information needs to be changed. First change the name to match your label size.
5. Change the Label Size and Layout. Use this information as a guide. In this example we will setup a 2.5” wide x 2” high label.

- Label Width and Height should match Page Width and Height
- A standard corner radius (rounded corner) is .125
- Paper Size should be set to “Other”
- Rows and Columns should be set to 1
- All Margins should be set to zero
- All Spacing should be set to zero
6. Click OK when the label is setup. Now select the label you setup from the Custom Tab. Click OK.

7. Add images, barcodes or text using the buttons across the top ribbon. For more information on how to setup a label and use the software, contact Belight or visit the Help menu. When you are ready to print, go to the file menu – print.
8. Choose the Color Label 910 as the printer and click Next.

9. You may print at this point. However, if you wish to adjust print settings, click on the Show Details button.

11. Set your Saturation, Ink and Quality settings according to the guide in section 5F. Click Print.
In many programs such as Adobe Illustrator, Photoshop or Acrobat Reader you will need to choose your label/page size before you print. If the label size you need to use is not already on the list of available pages sizes you will need to create a new custom size.

1. Open the program you would like to print from and select File – Page Setup. Using the Paper Size drop down menu select Manage Custom Sizes.

2. Add a New Custom Paper Size. Click the plus (+) button to add a new custom paper size. Enter the size on the right. Be sure to adjust the top, bottom, left and right margins to 0. Change the name from "untitled" to the size of your custom page (W x H).
G. CREATING A FULL BLEED PRINT

1. If you are having trouble making the image cover the entire label, first make sure the image is printing at least as big as the label size you have selected. Increase the selected page size by .03 inches on the width and .03 inches on the height to create an over bleed.

**Note:** Make sure under scaling options to select ‘Fit to Page’ in the print dialogue box if printing from Illustrator.

**Left Margin Offset.** You must decrease the Left Margin Offset to center the over bleed on the label. If you over bleed by .03 inches, you will need to decrease the Left Margin Offset by 4. This will center the page size increase so there is an over bleed on both the left and right sides.

**TOF.** Increase the Top Of Form by 4. This will cause the printer to start printing before the label and ensure a fully printed label.

![LX910Config](image)

**Note:** It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause the printer to skip labels. This is because the printer stops printing too late to sense the next label.
Printer driver settings are accessible on the print window of any application right before you click print. Click on the Layout dropdown menu and choose Printer Printer Features.

Print Quality

There are 4 levels of print quality in the driver. The lower the Quality, the faster the print. Quality 1 provides the fastest print available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when designing your label to find a good balance between print quality and print speed. Quality 2 is the default.
Bi-directional Printing

Set to "Yes" for fastest print speed. Requires an alignment print after every cartridge change. Set to "No" for better quality print (in some cases).

Color Matching

There are several options available depending on which cartridge is installed (Pigment or Dye). The options will update automatically depending on which cartridge is installed.

**Vivid Graphics** mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

**Vivid Photos** mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Vivid Graphics mode. Skin tones especially will look more natural in this mode.

-NONE- will use no color matching.

Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the most accurate color matching. If the ink is not drying fast enough or "bleeding", you can decrease the Ink Saturation to lessen the amount of ink that is applied to the label.
A. SOLVING PRINT ALIGNMENT PROBLEMS

Image is Vertically Offset

The LX910 decides where to start printing by detecting the start of die-cut label, detecting a black mark on the back of the label or detecting a through-hole that corresponds to the start of the label.

The following items can cause the label sensor to improperly detect the start of a label:

1. **Top of Form (TOF).** TOF stands for Top of Form and this setting allows you to fine tune the alignment of your printing on your label stock. This will be factory calibrated. If fine tuning is needed, increase this setting to move the image down on the label; decrease this setting to move the image up on the label. The unit of measure is 0.1mm. This setting is found on the Alignment Tab of the PrintHub and Print Utility (Mac).
2. **Nonstandard / Non-translucent Backing Material.** Test the unit with the label sample material that came with the unit. If it prints correctly, your label stock may not be compatible with the printer. The label sensor needs to see the difference between a label and a backing material by seeing through the label stock for light variations. If it cannot see through the label, problems will arise. If you must use this type of backing, try label stock that has a black mark on the back to show where the label begins. You will need to change the Stock Sensor Mode in the PrintHub or Printer Utility (Mac).

3. **Insufficient Label Gap Distance.** See Section 2A for label specifications.

4. **Page Size is Bigger than Label Stock Size.** If the page size set in the driver is larger than the actual label stock, ink will be printed on the gaps and the sensor will start looking for a gap too late. This can cause label skipping or inconsistent print starting points. Adjust the page size in the printer driver settings.

5. **Portrait / Landscape.** If the Portrait / Landscape setting does not correspond to the label stock installed this will also cause the printer to print over the gap and onto the next label. Make sure this is set correctly.

6. **Stock Sensor Position.** Circular, nonstandard label shapes or multiple labels across will require precise adjustment of the label sensor. If you are using circular or other non rectangular die-cut labels see Section 2C for instructions.

**The image is printing horizontally offset**

Three things can affect this issue.

**Label Stock Loading.** It is very important to correctly load the label stock so that there is no space between the throat guides and the label liner edge. If there is a gap between the throat guides and the label stock it may "walk" back and forth causing inconsistent horizontal printing. See section 2B for label stock loading instructions and tips.
**Left Margin Offset.** This adjustment is found on the Alignment tab of the PrintHub. See Section 4D.

**Page Size.** Often the page size is not large enough for the label. If this is the case you may see white space on the right (printer’s left) side of the the label and no image over-lap on the opposite side. This indicates that the page size needs to be increased. Increase the page size through the printer preferences enough to cover the label.
B. SOLVING PRINT QUALITY PROBLEMS

Many factors can affect the quality of the print. The following are listed in order from most likely to least likely:

1. **Quality Setting.** Change your quality setting. The lowest (and fastest printing) quality may not be sufficient for many photos or graphics. The highest quality setting may cause ink to bleed on certain graphics in combination with certain label stock. Increasing the quality increases print time because the printer makes more horizontal movements across the label.

2. **Clean the Cartridge.** Run an automatic cleaning print or manually clean the cartridge as described in Section 6D.

3. **Change the Cartridge.** Try a new cartridge. Make sure that the ink cartridge has ink remaining. Check the ink levels via the PrintHub or Printer Utility (Mac).

4. **Align Print Head.** Normally, print head alignment is only necessary after changing a print head. However, in certain cases, running the alignment again can improve print quality. Align the print head by opening the PrintHub or Printer Utility (Mac). Click on the Align Print Head button on the Cartridge Utilities Tab (second tab). Follow the onscreen prompts to load your paper for alignment.
5. **Clean the Maintenance Station.** Power off the printer! Gently move the cartridge to the left to access the maintenance station. Clean the maintenance station located on the right side of the print area. This includes the rubber cartridge nozzle cap and the plastic roller. Under normal use this can become dirty with ink. Clean with rubbing alcohol and a paper towel.

![Maintenance Station](image)

6. **Color Matching.** Change your Color Matching setting to Graphics or Photos via the printer driver preferences. See Section 4G or 5H.

7. **Media.** Make sure your label stock is inkjet printable. Many thermal label stocks look the same as inkjet but do not allow the ink to soak into the surface of the media.

8. **Source File Image Mode.** The image mode of the source file may be set to RGB instead of CMYK. This can cause the color matching to be off. Change the image mode of the original file, resave and reprint.

9. **Copper Contacts.** Clean the copper contacts on the back of the print carriage and the contacts on the print head with rubbing alcohol and a paper towel.
10. **Image Resolution (DPI).** Try another Image. Perhaps the resolution of the current image is not sufficient for a quality print. Many graphics suitable for viewing onscreen have a DPI of 72. This is the minimum DPI for proper screen display. However, if you print this image it will look blurry and pixilated. 72 is a typical DPI for images or graphics saved from web sites. We recommend a 300 DPI image.

11. **Cable.** Try another USB cable. Make sure that it is less than 6ft (2 Meters) long. Faulty cables or cables that are too long interrupt communications which can result in print quality issues.

12. **Saturation.** If ink is bleeding, decrease saturation in driver preferences.

### C. COLOR MATCHING AND DESIGN TIPS

Whether you contract your graphic design or do it yourself, these guidelines will help you get the best quality labels out of your LX910.

1. **Image Size/Shape.** The image size should correspond with the size of the label you will be printing.

   **Note:** If the source image is smaller and must be enlarged to fill the entire label space, this will affect the DPI. A 2" x 2" 300 DPI label blown up to fit on a 4" x 4" label would have an effective DPI of 75. This would not be a sufficient resolution. See item 2.

2. **Resolution.** Resolution is measured in dots per inch or dpi. 300 DPI is sufficient to get the best possible quality from most images. A 72 DPI image will look fine on screen but WILL NOT print well. Graphics and logos found on websites are typically 72 DPI. The image below was printed from a 72 DPI image. Notice the jagged edges. Remember, print quality settings found in the label printer driver will have no effect on improving a low DPI source image.
On the other hand, resolutions higher than 300 DPI will not produce better quality but may require more RAM to print and hard drive space to store. They could even slow down the print process.

3. **Image File Format.** Most graphics are created in a graphic application. Since this graphic application is not usually on the same computer as the label printer doing the printing, it is necessary to export the graphic into a universal format that can be read by other programs. We recommend TIF and BMP files for graphics. These formats are uncompressed. JPG files also work well for graphics that include photographs. All three formats can be imported into the BarTender application.

4. **Color Mode.** Set the color mode in the source graphic application to CMYK. In most cases this will produce the most accurate color reproduction of the image on screen. However, if CMYK is not producing the desired color matching try changing the source image to RGB and then exporting the image again in one of the universal formats mentioned above.

**Note:** Often it is useful to request that your graphic designer provide you with several different formats for you to try printing. For example you could request your image in six different formats: A JPG, BMP, and TIF in RGB color mode and a JPG, BMP and TIF in CMYK color mode.
5. **Color Matching Setting.** Experiment with the Color Matching setting in the printer preferences (Section 4G or 5H) to achieve the best color matching. There are multiple media type options which correspond with the various types of label stock sold by Primera. Match this setting to the media installed in the printer to achieve the closest color match to the screen. Each of these settings employs a slightly different color table developed specifically for the media type listed.

---

**D. POOR PRINT QUALITY - CLEANING THE CARTRIDGE**

It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you suspect a cartridge nozzle has become slightly dried out or clogged. If the cartridge has been left out of the printer more than 30 minutes, the ink in the print head nozzles may have dried. If you are having print quality problems, follow the steps below:

1. Before moving on to the next step, ensure that the ink level of the color cartridge is more than 10%. If the ink level is lower than 10%, replace the cartridge.
2. Try cleaning the cartridge using the clean function in the PrintHub or Printer Utility (Mac).
3. Determine if printing is now acceptable by printing your image.

If the sample has missing colors or voids within a color strip, remove the cartridge from the printer and proceed to step 4.

4. Prepare items needed for procedure.

Two Paper Towels
folded four times each

A Glass of Water

5. Soak the paper towels in water for 5 seconds.

*Note:* Do not squeeze water from paper towels after removing from water.
6. Place one paper towel on cartridge nozzles. Gently press the paper towel with your finger. Leave the paper towel on the nozzles for 30-40 seconds.

7. Wipe nozzles.

   A. Place second paper towel on flat/hard surface.
   B. Press the nozzles into the paper towel.
   C. Firmly tap the top of the cartridge three times to force the ink out.
   D. Wipe/Drag the cartridge in the direction indicated.
   E. Repeat until all colors are seen on the paper towel.

After wiping the nozzles, the paper towel should show all three colors.

If all three colors are present, proceed to step 8.

If the paper towel doesn’t show all three colors, then repeat step 7.

If paper towel still doesn't show all three colors repeating step 7, then replace the cartridge.
8. Dry cartridge.

9. Verify cartridge is now functioning properly by printing your label.

E. INTERPRETING THE PRINTER’S INDICATOR LIGHTS

Most error messages will appear on your computer screen via the PrintHub application or the Printer Utility (Mac). However, if the error prevents communication with the computer the LED lights may be used to help diagnose the problem.

<table>
<thead>
<tr>
<th>LED</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intermittent Flashing Pause</td>
<td>Printer is doing maintenance. Appears during start up or after a cartridge change.</td>
</tr>
<tr>
<td>Slow Flashing Power</td>
<td>Missing Label Stock.</td>
</tr>
<tr>
<td>Solid Power Light</td>
<td>Power is on.</td>
</tr>
<tr>
<td>Rotating Ink, Power and Pause LEDs</td>
<td>Firmware update is in progress - do not remove power or USB.</td>
</tr>
</tbody>
</table>
If you have difficulties in operating your Printer, the procedures in this manual and the software User's Guide should, in most cases, solve the problem. If you still have difficulty, contact the technical support using one of the methods listed below.

<table>
<thead>
<tr>
<th>Source</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primera Knowledge Base</td>
<td><a href="http://www.primera.com/kb">www.primera.com/kb</a></td>
</tr>
<tr>
<td>BarTender Software Help files</td>
<td>Open the software. Click on the Help Menu - Contents</td>
</tr>
<tr>
<td>Email Support</td>
<td><a href="http://www.primera.com/customer-support">www.primera.com/customer-support</a></td>
</tr>
<tr>
<td>Phone Support</td>
<td>763-475-6669 (Mon - Fri 8 a.m. - 6 p.m CST)</td>
</tr>
<tr>
<td>Chat Support</td>
<td><a href="http://www.primera.com">www.primera.com</a> - look for the chat prompt on lower right</td>
</tr>
</tbody>
</table>
Section 7: Technical Specifications

Print Method: Thermal inkjet
Print Resolutions: Up to 4800 DPI
Print Speeds: Draft Mode: 4.5" per second
Normal Mode: 1.8" per second
High Quality Mode: 0.8" per second
Print Head: New print head with every cartridge change
Ink Tanks: Single high capacity Cyan, Magenta, Yellow ink cartridge; process black
Colors: 16.7 million
Color Matching: ICC color profiles for all Primera-supplied media. Ability to add custom ICC color profiles for other media types.
Max. Print Width: 8.25" (209mm)
Media Width: 8.375" (212mm)
Media Types: Roll-fed pressure-sensitive labels, roll-fed tags, fan-fold labels or tags
Media Sensing: Moveable see-through sensor for die-cut labels; reflective sensor for labels and tags with black stripe; can use continuous and pre-printed labels and tags
Supply Roll: 6" (152mm) maximum diameter on 3" (76mm) core
Ink Level Warning: Calculates actual number of prints remaining based upon ink usage of graphics being printed (patent-pending)
Indicator Lights: Power, Pause, Ink
Controls: Pause, Load/Feed, Unload
Operating Systems: Window 7, 8, 10
Mac OS X 10.9+
Data Interface: USB 2.0
Label Design Software: Seagull Scientific BarTender® UltraLite Software Version included; can also be used with most other popular label design and graphics programs
Electrical Rating: 12VDC, 5.0A
Power Requirements: 100-240VAC, 50/60 Hz, 60 watts
Certifications: UL, UL-C, CE, FCC Class B
Weight: 36.5 lbs. (16.6 kg)
Dimensions: 17.25"W x 9.1"H x 17.25"D
(438mmW x 231mmH x 438mmD)
Align Print Head ................................................................. 61
Alignment Tab ................................................................. 41
Black Mark ........................................................................ 7
Cartridge Utilities Tab ....................................................... 61
Circular Labels ................................................................. 12
Color Matching ............................................................... 38, 57, 62, 65, 70
Continuous Stock ............................................................. 15, 45
Cost Estimator ................................................................. 19
Cutter ................................................................................ 15
Die-Cut ............................................................................. 14, 44
DPI ..................................................................................... 63
Fixed Throat Guide ........................................................ 34, 43
Full Bleed .......................................................................... 35, 55
Ink Low LED ...................................................................... 3
Ink Saturation .................................................................... 39, 57
Installing Label Stock ..................................................... 9
Label Cost .......................................................................... 20
Label Size .......................................................................... 32, 54
Label Tear Bar .................................................................... 3
Left Margin Offset .......................................................... 7, 34, 35, 43, 55, 60
Load/Feed Button ........................................................... 3
Low Ink Warning ............................................................ 20
Media Type ......................................................................... 70
Movable Throat Guide .................................................... 11
Orientation ......................................................................... 8, 38
Output Mode ....................................................................... 34, 43, 45
Power LED .......................................................................... 3
Print Alignment .............................................................. 33, 42, 58
Print Quality ........................................................................ 38, 56, 61, 65
Printer Driver Settings ..................................................... 36, 56
Printing ............................................................................. 23, 31, 32, 40, 47, 54
Resolution .......................................................................... 63
Sensor Type ......................................................................... 15, 45
Sensor Position ................................................................... 12, 59
Reflective ............................................................................ 7, 14, 44
Roll Arm.................................................................10
Roll Guide..............................................................9
Roll Specifications...................................................6, 8
Roll Stop.................................................................10
Tear Off Position.....................................................43
TOF ........................................................................35, 36, 43, 55, 58
Unload Button..........................................................3
Using BarTender ......................................................23